Preface

This document explains the procedure of the installation and the Confirmation of RFID Label Design and Encoding Management Pro (Hereafter, it is written, "This tool"). Be sure to read this document before using this tool.

➔ Please read the First Step Guide first.

■ Abbreviations and generic terms used in documents for Fujitsu RFID Integrated Label Solution

The documents use the following abbreviations and generic terms.

<table>
<thead>
<tr>
<th>Name</th>
<th>Abbreviation used in this document</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft® Windows® 7 Professional</td>
<td>Windows 7</td>
</tr>
<tr>
<td>Microsoft® Windows® 8.1 Professional</td>
<td>“Windows 8.1”</td>
</tr>
<tr>
<td>Microsoft® Windows® 10 Professional</td>
<td>“Windows 10”</td>
</tr>
<tr>
<td>Terminals where Windows 7, Windows 8.1, or Windows 10 has been installed</td>
<td>PC</td>
</tr>
<tr>
<td>Personal computer</td>
<td></td>
</tr>
<tr>
<td>Reader device for 2D barcode</td>
<td>“2D reader”</td>
</tr>
<tr>
<td>Reader/writer devices</td>
<td>&quot;Reader device*&quot;</td>
</tr>
<tr>
<td>RFID tags</td>
<td>Tag</td>
</tr>
<tr>
<td>Fujitsu’s RFID Integrated Label - 8Kbyte (Large/Medium/Small)</td>
<td>&quot;Large capacity RFID tag&quot; or &quot;high memory tag&quot;</td>
</tr>
<tr>
<td>Fujitsu’s RFID Integrated Label - 1Kbyte (Large/Medium/Small)</td>
<td></td>
</tr>
<tr>
<td>Fujitsu's 2-kilobit RFID tags</td>
<td>Tag</td>
</tr>
</tbody>
</table>

■ Trademarks

- Microsoft, Windows, .NET Framework, and .NET Compact Framework are registered trademarks of Microsoft Corporation in the United States and other countries.
- Other company names and product names in this document are trademarks or registered trademarks of respective companies. Note that system names and product names in this document are not always followed by trademark symbols such as ® or ™.

■ ATA (Air Transport Association of America) Spec 2000 Chapter 9-5

- This tool is designed to read and write data from and to tags in compliance with the specification for Radio Frequency Identification (RFID) on Parts in ATA Spec2000 Chapter 9-5.
**High Risk Activity**

- This product is designed and manufactured as contemplated for general use, including without limitation, general office use, personal use and household use, but is not designed and manufactured as contemplated for use accompanying fatal risks or dangers that, unless extremely high safety is secured, could lead directly to death, personal injury, severe physical damage or other loss (hereinafter called "High Safety Required Use"), including without limitation, nuclear reaction control, aircraft flight control, air traffic control, mass transport control, life support, and weapon launch control. The customer shall not use this product without securing the sufficient safety required for the High Safety Required Use.

**Notes on export procedures**

- When exporting or providing this product and this document, check the regulations under the Foreign Exchange and Foreign Trade Law and the laws and regulations relating to US export control, and complete the necessary procedures.

**Screenshots and illustrations**

- The screenshots and illustrations in this document are only examples, and the actual screens may be slightly different depending on the environment that you are using.
- The screenshots used in the explanations in this document are from a Windows 7 environment.

**Other Notes**

- No part of this document may be reproduced or reused for other purposes without the express written permission of Fujitsu Limited.
- The content of this document may change without prior notice.
### Revision history

<table>
<thead>
<tr>
<th>Edition</th>
<th>Date issued</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version 1.00</td>
<td>June 2014</td>
<td>Initial version released.</td>
</tr>
<tr>
<td>Version 1.10</td>
<td>March 2015</td>
<td>Support for Windows 8.1</td>
</tr>
<tr>
<td>Version 1.11</td>
<td>June 2015</td>
<td>Installation procedure changed.</td>
</tr>
<tr>
<td>Version 1.20</td>
<td>September 2015</td>
<td>Add Commissioning from 2D and Batch Commissioning</td>
</tr>
<tr>
<td>Version 1.21</td>
<td>October 2015</td>
<td>Small changes.</td>
</tr>
<tr>
<td>Version 1.22</td>
<td>January 2016</td>
<td>Changes for LAN connection with ZXP-7</td>
</tr>
<tr>
<td>Version 1.23</td>
<td>October 2016</td>
<td>For the first enhancement in 2016</td>
</tr>
</tbody>
</table>
## CONTENTS

1 Overview .................................................................................................................. 1

1.1 Product Overview ................................................................................................. 1

1.2 Installation Prerequisites ...................................................................................... 3

   1.2.1 PC .................................................................................................................. 3

   1.2.2 RFID Tags ..................................................................................................... 4

   1.2.3 RFID Printer .................................................................................................. 4

1.3 Quick Installation Guide ....................................................................................... 5

2 BarTender Installation .............................................................................................. 6

2.1 Pre-installation Planning ....................................................................................... 6

2.2 Install the BarTender on a single computer ......................................................... 7

2.3 Add the BarTender on multiple computers ......................................................... 15

3 Set up Printer ........................................................................................................... 24

   3.1 ZXP-7 ................................................................................................................. 24

      3.1.1 Install the ZXP-7 Tools ............................................................................... 24

      3.1.2 Install the ZXP-7 Printer Driver ................................................................. 30

      3.1.3 Set up the Printer Preferences ................................................................... 44

   3.2 Label Printer ....................................................................................................... 49

      3.2.1 Setting up the Printer Preferences ............................................................... 49

4 RFID Label Design and Encoding Management Pro Installation ....................... 52

   4.1 Install the RFID Label Design and Encoding Management Pro ...................... 52

      4.1.1 In the Case that the ODBC driver of Microsoft Office is Already Installed ... 52

      4.1.2 In the Case that the ODBC driver of Microsoft Office is not Installed ....... 58

   4.2 Manual Feed Settings in BTW Files ................................................................. 63

5 Testing ...................................................................................................................... 67

   5.1 Encode and Print a Test Tag .............................................................................. 67

6 Uninstallation ............................................................................................................. 71

   6.1 Uninstall the BarTender and Seagull Licensing Server .................................... 71

   6.2 Uninstall the BarTender ..................................................................................... 77

   6.3 Uninstall the ZXP-7 SDK and Printer Driver ................................................... 81

   6.4 Uninstall the RFID Label Design and Encoding Management Pro ............... 85
1 Overview

1.1 Product Overview

RFID Label Design and Encoding Management Pro can initialize RFID tags in the ATA formats specified in ATA Spec2000 Chapter 9-5, and print the label on RFID tags by RFID printer. This tool consists of the following 5 applications.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Designing</td>
<td>This application is for label designing and printing for RFID tags.</td>
</tr>
<tr>
<td>Commissioning by Barcode Scanning</td>
<td>This application enables to create commission data by scanning barcode which contains the search key. After scanning barcode, this application automatically searches and extracts a data record from a database, and sets it as commission data.</td>
</tr>
<tr>
<td>Batch Commissioning</td>
<td>This application extracts multiple data records by search key from a database and creates commission data for multiple tags one time.</td>
</tr>
<tr>
<td>Commissioning from Integrated Sources</td>
<td>The commission does one tag to this application. The input method is a hand input or a database input or fixed value input.</td>
</tr>
<tr>
<td>Manual Input</td>
<td>This application creates commission data based on the data input by manual or CSV/XML file.</td>
</tr>
</tbody>
</table>

This document explains the procedure to install the above applications. Please refer to the each user manual for the application details and the usage.

<table>
<thead>
<tr>
<th>Manual title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started with the BarTender Application Suite</td>
<td>Explains how to use the Label Designing function of “RFID Label Design and Encoding Management Pro”.</td>
</tr>
<tr>
<td>RFID Label Design and Encoding Management Pro User’s Guide (Commissioning by Barcode Scanning)</td>
<td>• Explains how to use the Commissioning by Barcode Scanning application of “RFID Label Design and Encoding Management Pro”.</td>
</tr>
<tr>
<td>Manual title</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>RFID Label Design and Encoding Management Pro User's Guide (Commissioning from Integrated Sources)</td>
<td>• Explains how to use the Commissioning from Integrated Source application of “RFID Label Design and Encoding Management Pro”.</td>
</tr>
</tbody>
</table>
| RFID Label Design and Encoding Management Pro User's Guide (Batch Commissioning) | • This is the present document  
• Explains how to use the Batch Commissioning application of “RFID Label Design and Encoding Management Pro”. |
1.2 Installation Prerequisites

The following hardware and settings are required to install and use this tool.

1.2.1 PC

1.2.1.1 Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>A CPU with a 1.0 GHz processor or higher (manufactured by Intel or AMD)</td>
</tr>
<tr>
<td>Memory</td>
<td>1 GB or more</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>400 MB or more</td>
</tr>
<tr>
<td>Text resolution</td>
<td>96 DPI</td>
</tr>
<tr>
<td>Display size</td>
<td>XGA (1024 x 768) or higher</td>
</tr>
</tbody>
</table>

- Reference: Administrator rights on the PC are necessary to install this tool.

1.2.1.2 Software Requirements

- Windows 7 Professional Service Pack 1 (64-bit edition), Windows 8.1 Professional (64-bit edition), or Windows 10 Professional (64-bit edition)
- .NET Framework 3.5
- .NET Framework 4.5.1 or the compatible version
- Microsoft Office 2010 or later (every edition) Access and Excel
- SEAGULL BarTender Enterprise Automation 10.1 Software (provided with the CD)
- ZXP7ToolsSetup.exe Software (provided with the CD)
- ZEBRA_7.4.3 Printer Driver (provided with the CD)
- RFID Label Design and Encoding Management Pro Software (provided with the CD)

- Reference: Both .NET versions 3.5 and 4.5.1 (or the compatible version) need to be installed on the PC.
  - .NET Framework 3.5 is preinstalled on Windows 7.
  - .NET Framework 4.5.1 or the compatible version is preinstalled on Windows 8.1, Windows 10.
1.2.2 RFID Tags

This tool supports the following RFID Tags
- Fujitsu’s RFID Integrated Label – 1KByte Large
- Fujitsu’s RFID Integrated Label – 1KByte Medium
- Fujitsu’s RFID Integrated Label – 1KByte Small
- Fujitsu’s RFID Integrated Label – 8KByte Large
- Fujitsu’s RFID Integrated Label – 8KByte Medium
- Fujitsu’s RFID Integrated Label – 8KByte Small
- Fujitsu’s RFID Integrated Label Slim – 2Kbit

1.2.3 RFID Printer

(1) RFID printer for Fujitsu’s RFID Integrated Label 1Kbyte/8Kbyte

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Type</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zebra Technologies</td>
<td>Card Printers (UHF)</td>
<td>ZXP Series 7 Card Printers (UHF)</td>
</tr>
</tbody>
</table>

(2) RFID printer for Fujitsu’s RFID Integrated Label Slim – 2Kbit

Recommended label printer is Zebra Technologies’ ZT410R (300dpi).
1.3 Quick Installation Guide

The following shows the overview of installation operations.

(1) Log in to the PC (as Administrator or with admin rights).
(2) Install the BarTender Software and the Seagull Licensing Server.
(3) Install the printer driver for ZXP-7 printer.
   i. Run the “ZXP7ToolsSetup.exe” to install the ZXP-7 Tools..
   ii. Connect the printer via USB or LAN cable to the PC and power on the printer
   iii. Run the “Zebra_n.n.n.exe” to install the ZXP-7 Driver.
   iv. Set up the Zebra ZXP Series via the printer preferences and properties.
(4) Run the “Setup.exe” to install the RFID Label Design and Encoding Management Pro Software.

! Caution
• It is necessary to use a label printer in order to use “Fujitsu’s RFID Integrated Label Slim – 2Kbit”. In that case, it is necessary to setup the label printer instead of “(3) Install the printer driver for ZXP-7 printer”.

2 BarTender Installation

First, please install BarTender which is one of components of Fujitsu Label Design and Encoding Management Pro. This application includes label design and print function for RFID Integrated Labels.

2.1 Pre-installation Planning

Before you start installation, you will need to decide which PC to install BarTender on. Necessary software for using the BarTender is as below.

- **In the case of installing BarTender on a single computer**: it is necessary to install both BarTender and Seagull Licensing Server on the same computer (please refer to the 2.2 Install the BarTender on a single computer).

  - **Reference**: The Seagull License Server application is installed together with the BarTender Software automatically.

- **Adding BarTender on multiple computers**: at first install both BarTender and Seagull Licensing Server on a single computer on a network. (please refer to the 2.2 Installing the BarTender on a single computer) Then, install only BarTender on other computers (please refer to 2.3 Add the BarTender on multiple computers for the operating procedure).

  - **Reference**: Please refer to *Getting Started with the BarTender Application Suite* for more details about Seagull License Server.

  - **Caution**: To refer to the manual of BarTender, the following Files on the RFID Label Design and Encoding Management Pro CD are started.

    - `\Seagull BarTender10.1\StartMenu\main.html`
    - The reference of the manual can be done by clicking Link of "Getting Started" Manuals" that exists in the menu.
2.2 Install the BarTender on a single computer

**Operating procedure**

1. Turn on the PC where this tool is to be installed and log in as either the PC administrator or a member of the Administrators group.
2. Insert the RFID Label Design and Encoding Management Pro CD into your computer’s CD drive.
3. Open the “\Seagull BarTender10.1\BT32” folder of the CD using Explorer and double click the “setup.exe”.

**Caution**

- If the PC does not have a CD drive, use another PC to copy the content of the “\Seagull BarTender10.1\BT32” folder on the CD to USB memory (or a similar device), and then execute “setup.exe” from there.

4. Select the language and click the OK button.
(5) Click the **Next** button.

(6) Check “I accept the terms in the license agreement” and click the **Next** button.
(7) Select “Enterprise Automation” and click the **Next** button.

(8) Check “Seagull License Server” and click the **Next** button.

**Reference:** In this case (for a single computer) the License Server need to be installed on the PC the RFID Label Design Software is installed and the ZXP7 Printer is connected to.
(9) Click the **Next** button.

![Service Configuration window](image)

(10) Click the **Install** button.

![Review Options window](image)
(11) The installation of the BarTender will start. It takes a few minutes to install. Please wait until Installation to be completed.

(12) After the installation is completed, click the **Activate Now...** button.

**Reference:** • It is also possible to activate it via Internet.
(13) Enter the product key and click the **Next** button.

(14) Check "I Agree" and click the **Next** button.
(15) Select your country and click the **Next** button.

(16) Click the **Next** button.
! Caution

- Need Internet access for this activation process.
- If Internet access is not available on the computer, please do another activation method according to the instructions on the installation wizard.

(17) Click the Finish button.

This completes the installation procedure for the BarTender and the Seagull Licensing Server.
2.3 Add the BarTender on multiple computers

If you want to additionally install BarTender on multiple computers, please continue the following operations and install only BarTender on other computers. Otherwise, please skip to Section 3 ZXP-7 Driver Installation.

**Operating procedure**

1. Prepare other computers and log in as either the PC administrator or a member of the Administrators group.
2. Insert the BarTender CD into your computer’s CD drive.
3. Open the “\Seagull BarTender10.1\BT32” folder of the CD using Explorer and double click the "setup.exe".

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If the PC does not have a CD drive, use another PC to copy the content of the “\Seagull BarTender10.1\BT32” folder on the CD to USB memory (or a similar device), and then execute &quot;setup.exe&quot; from there.</td>
</tr>
</tbody>
</table>

4. Select the language and click the OK button.
(5) Click the **Next** button.
(6) Check "I accept the terms in the license agreement" and click the Next button.

(7) Select “Enterprise Automation” and click the Next button.
(8) Click the **Next** button.

---

**Caution**
- Please do not check “Seagull License Server” when installing only the BarTender copy.
(9) Click the **Next** button.

(10) Click the **Install** button.
(11) The installation of the BarTender will start.

(12) After the installation is completed, check the “Run BarTender” and click the **Finish** button.
(13) The BarTender application will start up. Click the **Close** button.

(14) Select “Licensing setup” in “Administer” menu.
(15) Enter the IP address of the Seagull Licensing Server and click the OK button.

! Caution • Need TCP/IP connectivity with the Seagull Licensing Server for this activation process.

(16) Select “About…” in the “Help” menu.
(17) Check the Activation Status is “Activated” and click the **OK** button.

This completes the installation procedure for the BarTender.
3 Set up Printer

3.1 ZXP-7

3.1.1 Install the ZXP-7 Tools

■ Operating procedure

(1) Open the root folder of the CD using Explorer, and then double-click the "ZXP7ToolsSetup.exe".

![Image of CD contents]

(2) If the following warning dialog box is displayed, click the Yes button.

![Warning dialog box]

Reference:  
- Please click the Yes button similarly if the warning dialog box is displayed at
  the following.
(3) Click the **Next** button.

![Seagull Install for Zebra ZXP 7 Setup](image)

(4) Select "I accept the terms in the license agreement" and then click the **Next** button.

![License Agreement](image)

(5) Click the **Install** button.

![Ready to Install the Program](image)
(6) The installation of this driver will start.

Reference:

- Please click the Install button if the following screen is displayed.

- Please click the Close button if the following screen is displayed.
(7) Select Command Prompt Window, press “Enter” key.

(8) Select “FTDI Chip CDM Drivers” Window, click the Extract button.

! Caution • If you do not see above screen then because it is direct behind the Device Driver Installation Wizard. In this case please move the away (don’t close) the Wizard to another place or click on the icon in the task bar
(9) Click the **Next** button.

(10) The installation of this driver will start.
(11) Click the **Finish** button.

(12) After the installation completes, click the **Finish** button.
3.1.2 Install the ZXP-7 Printer Driver

There are 2 options to install ZXP-7 printer driver; (1) USB connection and (2) LAN connection. Please perform either of 3.1.2.1 Install the ZXP-7 Printer Driver via USB or 3.1.2.2 Install the ZXP-7 Printer Driver via LAN.

3.1.2.1 Install the ZXP-7 Printer Driver via USB

(1) Connect RFID Printer “Zebra ZXP Series 7 (UHF)” with PC using USB cable.

! Caution  • The Printer always must be connected to the USB port you have used during installation!

(2) The driver of the printer is installed.

(3) There is no problem though the installation of the printer driver fails.

(4) Double-click the “Zebra_n.n.n.exe” in the Driver folder in the CD.
(5) Select “I accept the terms in the license agreement”, click the Next button.

(6) Click the Next button.
(7) Click the Finish button.

(8) Select “Install printer drivers”, click the Next button.
(9) Click the **Next** button.

(10) Click the **Next** button.
(11) Click the **Finish** button.

![Click the Finish button](image)

(12) The installation of this driver will start.

![Installation progress](image)

(13) Click the “Install”.

![Windows Security dialog box](image)
(14) After the installation completes, click the **Close** button.
(15) Click the “Devices and Printers” in Start Menu of Windows.

(16) Check that ZXP-7 Driver has been successfully installed.

This completes the installation procedure for this driver.
3.1.2.2 Install the ZXP-7 Printer Driver via LAN

(1) Connect RFID Printer “Zebra ZXP Series 7 (UHF)” with the network using LAN cable.
(2) Double-click the “Zebra_n.n.n.exe” in the Driver folder in the CD.

(3) Select “I accept the terms in the license agreement”, click the Next button.

(4) Click the Next button.
(5) Click the **Finish** button.

(6) If the following warning dialog box is displayed, click the **Yes** button.

(7) Select "Install printer drivers", click the **Next** button.
(8) Select “Network (Ethernet or WiFi)”, click the **Next** button.

(9) Select “Zebra ZXP Series 7”, click the **Next** button.

(10) Click the **Create Port…** button.
(11) Select “Standard TCP/IP Port”, click the **New Port…** button.

![Create Port](image)

(12) Click the **Next** button.

![Add Standard TCP/IP Printer Port Wizard](image)

(13) Enter the IP address into the “Printer Name or IP Address” box and click the **Next** button.

![Add Standard TCP/IP Printer Port Wizard](image)
(14) Click the **Finish** button.

(15) Click the **Close** button.

(16) Click the **Next** button.
(17) Click the **Next** button.

(18) Click the **Finish** button.

(19) After the installation completes, click the **Close** button.
Caution

- If Windows Firewall is enabled on the PC, it is necessary to configure the settings to allow inbound connections on the following ports in advance.

Seagull Driver Port 9100, 19540 (TCP, UDP)
3.1.3 Set up the Printer Preferences

This section explains the setup procedure for the Zebra ZXP Series 7 (UHF).

Note: Refer to the ZXP Series 7 manual for details.

- Operating procedure

1. Connect ZXP-7 with PC.

2. Open Windows’ Devices and Printers from the Start Menu.
   Right click the driver, and select Printing Preferences.

3. Choose the Graphics tab and select ‘K-Black (resin)’ for Ribbon Setup Type, continue with the Apply Button.
(4) Choose the **Stock Tab** and select ‘**Feeder**’ or ‘**ATM Slot**’ for Card Setting Source and confirm settings with the **OK** button.

**Reference:**
- Select ‘**Feeder**’ if using the Feed Cartridge.
- Select ‘**ATM Slot**’ if using the Manual Feed Slot.

---

**(i) Feed Cartridge (default)**

**(ii) Manual Feed Slot**

---

(5) Right click the driver, and select **Printer Properties**

(6) Choose the **Tools Tab** and click the “Configure”, then select the ‘Smart Card Options’ from the pull-down.
(7) Select the **EPC Gen2** tab.

(8) Choose “Lock Permanently” for EPC Memory

(9) Choose “Lock Permanently” for User Memory.

(10) Choose “Open” for TID Memory.


(12) Choose “Lock Permanently” for Kill Password.

(13) Input “00000000” to New Password of Access Password.
(14) Click the **Range** button.

(15) Selected “Lock modified blocks when specified”
   Click the **OK** button.

(16) Click the **OK** button.
(17) Click the **Tools** tab and Select ‘Action’.

(18) Click the “Read Printer Information” and click the **Close** button.

(19) Click the **OK** button to confirm the settings and to close the Window.
3.2 Label Printer

This section explains the setup procedure for the Zebra ZT410 as an example.
Note: Refer to the ZT410 manual for details. Need to calibrate the position of tags according to the manual, before encoding and printing tags.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If you use another label printer, please configure equivalent settings according to the setup procedure provided by the printer manufacturer or supplier.</td>
</tr>
</tbody>
</table>

3.2.1 Setting up the Printer Preferences

■ Operating procedure
(1) Connect ZT410 with PC.
(2) Open Windows’ Devices and Printers from the Start Menu.
   Right click the driver, and select Printer Properties
(3) Choose the **Tools** Tab and click “Configure”, then select ‘Smart Card Options’ from the pull-down.

(4) Select the **EPC Gen2** tab.

(5) Choose “Lock Permanently” for EPC Memory
(7) Choose “Lock Permanently” for Kill Password.
(8) Input “00000000” to New Password of Access Password.
(9) Choose “Lock Permanently” for User Memory.
Lock settings of User Memory is different depending upon record type of the tag.

A) Commissioning Dual Record Tag
Select Lock specified range. and Set Start Section:0, Number of Sections:4
Click the OK button.

B) Commissioning Single Birth Record Tag
Select Lock entire memory bank. Click the OK button.

C) Commissioning Single Utility Record Tag
Select Open for User Memory.
4 RFID Label Design and Encoding Management Pro

Installation

4.1 Install the RFID Label Design and Encoding Management Pro

Reference: If the version V01L01R2 of this tool is installed on your computer, it can be updated to V01L02R2 using this setup module. Please refer to the “Program Update Guide to V01L02R2. - RFID Label Design and Encoding Management Pro” for more detailed procedure.

4.1.1 In the Case that the ODBC driver of Microsoft Office is Already Installed

Operating procedure

(1) Insert the RFID Label Design and Encoding Management Pro CD into your computer’s CD drive.

(2) Open the root folder of the CD using Explorer, click the “\LDEMP_V01\Module” folder and then double-click the “Setup.exe”.

Caution: If the PC does not have a CD drive, use another PC to copy the “\LDEMP_V01\Module” folder to USB memory (or a similar device), and then double-click the “Setup.exe” from there.
(3) The version (32-bit or 64-bit) of the ODBC driver of Microsoft Office installed on the computer is automatically detected and displayed on the screen. Click the **Next** button.

- In the case that the 32-bit ODBC drivers are installed.

- In the case that the 64-bit ODBC drivers are installed.

---

**Caution**

- This tool is only supported for a 64-bit operating system. Even if the installer is executed on a 32-bit operating system, this tool would not be installed.
(4) Select program version (32-bit or 64-bit) of LDEMP, and click the Next.

- In the case that the 32-bit ODBC drivers are installed.
- In the case that the 64-bit ODBC drivers are installed.

! Caution

- It is necessary to select same version (32-bit or 64-bit) with ODBC driver installed on the computer if Microsoft Office file will be used for data source.
- If other ODBC drivers will be used, it is necessary to select the same version with the ODBC drivers.
(5) Click the **Install** button.

(6) Click the **Next** button.
(7) Click the **Install** button.

(8) Click the **Finish** button.
(9) After the installation completes, click the **Finish** button.

(10) When the installation completes, **Fujitsu / RFID Label Design And Encoding Management Pro** will be registered under the **Start / Programs** menu. The following icon will also be created on the desktop: **RFID Label Design And Encoding Management Pro**.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name of the desktop icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFID Label Design &amp; Encoding Management Pro</td>
<td>RFID Label Design And Encoding Management Pro</td>
</tr>
</tbody>
</table>

(11) Remove the setup CD from the PC.

(12) Restart the PC manually.

This completes the installation procedure for this tool.
4.1.2 In the Case that the ODBC driver of Microsoft Office is not Installed.

**Operating procedure**

1. Insert the RFID Label Design and Encoding Management Pro CD into your computer’s CD drive.
2. Open the root folder of the CD using Explorer, click the “\LDEMP_V01\Module” folder and then double-click the “Setup.exe”.

**Caution**

- If the PC does not have a CD drive, use another PC to copy the “\LDEMP_V01\Module” folder to USB memory (or a similar device), and then double-click the “Setup.exe” from there.
(3) The message “Any ODBC drivers related to this program were not found on this machine” is displayed on the screen. Click the **Next** button.

(4) Select program version (32-bit or 64-bit) of LDEMP, and click the **Next**.

---

**Caution**

- If other ODBC drivers will be used, it is necessary to select the same version with the ODBC drivers.
(5) Click the **Install** button.

![Install button](image1)

(6) Click the **Next** button.

![Next button](image2)
(7) Click the **Install** button.

(8) Click the **Finish** button.
(9) After the installation completes, click the **Finish** button.

(10) When the installation completes, **Fujitsu / RFID Label Design And Encoding Management Pro** will be registered under the **Start / Programs** menu. The following icon will also be created on the desktop: **RFID Label Design And Encoding Management Pro**.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name of the desktop icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFID Label Design &amp; Encoding Management Pro</td>
<td>RFID Label Design And Encoding Management Pro</td>
</tr>
</tbody>
</table>

(11) Remove the setup CD from the PC.

(12) Restart the PC manually.

This completes the installation procedure for this tool.
4.2 Manual Feed Settings in BTW Files

The sample BTW files included in this tool are configured to use the Feed Cartridge as default. If using the Manual Feed Slot, please modify the settings in the sample BTW files.

! Caution
• If using the Feed Cartridge, please skip this section.

■ Operating procedure
(1) Connect RFID Printer "Zebra ZXP Series 7 (UHF)" with PC using USB cable.
(2) Open the BTW file.

Reference:
• Sample BTW files for the Commissioning by Barcode Scanning, the Batch Commissioning, and the Commissioning from Integrated Sources are stored in the following folder.
  C:\Users\Public\RFID Label Design and Encoding Management Pro\CommissionData
• Sample BTW files for the Manual Input are stored in the following folder.
  C:\Users\Public\RFID Label Design and Encoding Management Pro\Manual Input\printdata

(3) Select Print… in the File menu.
(4) Click the **Document Properties**…

![Document Properties screenshot](image)

(5) Click the **Stock** tab and select ‘ATM Slot’ for the Card Setting Source.

![Stock tab screenshot](image)
(6) Click the **OK** Button.

(7) Click the **Close** Button.
(8) Save the BTW file.

(9) Close the BTW file.

This completes the setting procedure for the Manual Feed Slot in BTW file.
5 Testing

5.1 Encode and Print a Test Tag

This section explains you to initiate a test print in order to see if the installation and setup has been completed correctly and that everything is working.

| Caution | • The ODBC driver of Microsoft Office is necessary to be installed on PC in order to perform testing. |

**Operating procedure**

1. To start this tool, click the icon of **RFID Label Design and Encoding Management Pro** that has been placed on the computer desktop.

2. Click the **Batch Commissioning** button.
(3) Click the **Work Order** button.

(4) Select the applicable sample data and click the **Select** button (in this example, we have used the Work Order “0002-00001” which is for 8KByte Large tags).

**Reference:**
- Please confirm the applicable Work Order from the following table.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Tag</th>
<th>Work Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dual</td>
<td>1KByte Large</td>
<td>0001-00001</td>
</tr>
<tr>
<td>Dual</td>
<td>1KByte Medium</td>
<td>0001-00002</td>
</tr>
<tr>
<td>Dual</td>
<td>1KByte Small</td>
<td>0001-00003</td>
</tr>
<tr>
<td>Dual</td>
<td>Slim 2Kbit</td>
<td>0001-00004</td>
</tr>
<tr>
<td>Multi</td>
<td>8KByte Large</td>
<td>0002-00001</td>
</tr>
<tr>
<td>Multi</td>
<td>8KByte Medium</td>
<td>0002-00002</td>
</tr>
<tr>
<td>Multi</td>
<td>8KByte Small</td>
<td>0002-00003</td>
</tr>
<tr>
<td>Single Birth</td>
<td>Slim 2Kbit</td>
<td>0003-00001</td>
</tr>
<tr>
<td>Single Utility</td>
<td>Slim 2Kbit</td>
<td>0003-00002</td>
</tr>
</tbody>
</table>
(5) Sample data is displayed on the screen.
(6) Select only the first record and click the **Commission** button.

(7) Please wait for the message “Printing data has been successfully transmitted”, then insert the tag into the printer.

(8) Finish the test printing via the **Close** button.

If the tag is successfully commissioned, the installation and setup has been completed correctly. If not, please contact Fujitsu Customer Support.
6 Uninstallation

6.1 Uninstall the BarTender and Seagull Licensing Server

This section explains how to uninstall the BarTender and the Seagull Licensing Server.

- Operating procedure
  (1) Select Control Panel, Programs and then Programs and Features from the Start menu.
  (2) Select BarTender 10.1 from the Uninstall or change a Program list, and then click the Change button.
  (3) Select Remove and click the Next button.
(4) Click the **Next** button.

(5) Select “Deactivation Now” and click the **Next** button.
(6) Click the **Next** button.

![Activation Wizard](image1)

(7) Click the **Next** button.

![Activation Wizard](image2)
! Caution

• Need Internet access for this deactivation process.
• If Internet access is not available on the computer, please do another deactivation method according to the instructions on the installation wizard.

(8) Click the Finish button.
(9) Uninstallation of the BarTender will start.

(10) Click the **Finish** button.
(11) Check that BarTender 10.1 has been deleted from the currently installed programs list.
(12) Restart the PC manually.

This completes the uninstallation procedure for the BarTender and the Seagull Licensing Server.
6.2 Uninstall the BarTender

This section explains how to uninstall the BarTender.

- Operating procedure
  
  (1) Select **Control Panel, Programs** and then **Programs and Features** from the **Start** menu.

  (2) Select **BarTender 10.1** from the **Uninstall or change a Program** list, and then click the **Change** button.

  (3) Select **Remove** and click the **Next** button.
(4) Click the **Next** button.

(5) Select “Deactivation Now” and click the **Next** button.
(6) Click the **Next** button.

(7) Click the **Finish** button.
(8) Uninstallation of the BarTender will start.

(9) Click the **Finish** button.
(10) Check that BarTender 10.1 has been deleted from the currently installed programs list.
(11) Restart the PC manually.

This completes the uninstallation procedure for the BarTender.

6.3 Uninstall the ZXP-7 SDK and Printer Driver

This section explains how to uninstall the ZXP-7 SDK and Printer Driver.

| Caution | • Please pull out the USB cable before uninstalling this driver. |

**Operating procedure**

(1) Double-click the "C:\Seagull\DriverWizard.exe".

(2) Select "Remove printer drivers", click the **Next** button.
(3) Select “Remove printers”, click the **Next** button.

(4) Select “Zebra ZXP Series 7”, click the **Next** button.
(5) Click the **Finish** button.

(6) Click the **Restart** button.

**Reference:**  • Please click the **Restart** button if this screen is displayed again.
(7) After reboot PC, click the **Close** button.

![Seagull Driver Wizard](image)

(8) Delete "C:\Seagull" Folder.

(9) Select **Control Panel**, **Programs** and then **Programs and Features** from the **Start** menu.

(10) Uninstall the following three programs.
- Seagull Install for Zebra ZXP 7
- Windows Driver Package – FTDI CDM Driver Package
- Windows Driver Package – FTDI CDM Driver Package

![Programs and Features](image)

This completes the uninstallation procedure for the ZXP-7 SDK and Printer Driver.
6.4 Uninstall the RFID Label Design and Encoding Management Pro

This section explains how to uninstall the RFID Label Design & Encoding Management Pro application.

### Operating procedure

1. Select **Control Panel, Programs** and then **Programs and Features** from the **Start** menu.
2. Select **RFID Label Design And Encoding Management Pro** from the **Uninstall or change a Program** list, and then click the **Uninstall** button. Click the **Yes** button.
(3) Select **RFID LDEMP Installation Tool** from the **Uninstall or change a Program** list, and then click the **Uninstall** button. Click the **Yes** button.

(4) Check that RFID Label Design and Encoding Management Pro has been deleted from the currently installed programs list.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Folders that contain the files created after the installation will not be deleted.</td>
</tr>
<tr>
<td>• If these folders need to be deleted completely, use Explorer or some other file manager to directly delete the &quot;Program Files\Fujitsu\AIT\RFID Label Design and Encoding Management Pro&quot; folder and &quot;C:\Users\Public\RFID Label Design and Encoding Management Pro&quot; folder and &quot;C:\Users\Public\Public Documents\Fujitsu\RFID Label Design and Encoding Management Pro&quot; folder.</td>
</tr>
</tbody>
</table>

(5) Restart the PC manually.

This completes the uninstallation procedure for this tool.